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| Theta Xi President

. »
Dave Loomis an-|

nounced yesterday that their fraternity |

| has decided to go substance free.

Entertainers showboat their talents
Schools give thumbs-up; thumbs down

Cindy Wiedmeyer

AssISTANT FEATURES EDITOR

Entertainers from across
the country traveled to
UW-Stevens Point for the
annual National Associa-
tion for Campus Activities
(NACA) conference last
weekend. Students and fac-
ulty from 46 Midwest uni-
versities opened their eyes
and ears to humor, music
and stunts as comedians,
bands, jugglers and magi-
cians took the stage hop-
ing to land contracts for the
next school year.

NACA provides assis-
tance for universities by es-

tablishing and producing
quality campus activities
programming by providing

Outrageous comedian
Katsy Chappell per-
forming at the NACA
conference.

education, information and
resources for students and
administration. “NACA is
an excellent resource for
students involved to gather
ideas and network between
schools and associates,”
said Frank Hammen, Host
School Committee member.

This year’s NACA con-
ference was filled with edu-
cational sessions teaching
leadership, programming
basics and professional de-
velopment. Students en-
gaged in these high impact
educational lectures and
hands-on activities were
challenged to bring back

SEE AcTs ON PAGE 2

SGA travels to Washington D.C.

Five representatives
from S.G.A. descended on
Capitol Hill to meet with leg-
islators on April 8th. The
representatives included
S.G.A president Jessica
Hussin, Legislative Issues
director Ann Finan and
senators Kevin Lahner,
Michael Roth and Jason
Beauchene. They went to
lobby our legislators on
student issues, specifically
the Reauthorization of the
Higher Education Act.

The Higher Education
Act is a key piece of legis-
lation directly affecting the
students at UW-Stevens
Point. It is responsible for
the Pell Grant, student
loans, and a variety of other
programs designed to help
students have access to
higher education.

“Reauthorization only
happens every five years,
so right now is the prime
time to lobby our legislators
on student issues,” said
Raghu Devaguptapu, Leg-
islative Affairs director at
United Council.

The Point delegation
talked to Representative
Dave Obey, and congres-
sional aides for Represen-
tative Sensenbrenner and
Senators Kohl and
Feingold. They also deliv-
ered over 700 postcards to
each congressman as part
of the Reauthorization post
card campaign.

“ As we expected we got
very good responses from
Obey, Kohl, and Feingold
and were disappointed with
Sensenbrenner. 1 think it
was good to let all of them

know that education is a key
issue this year and we will
be watching,” said Lahner.

Also part of the trip was
a conference put on by the
United States Student As-
sociation. At this confer-
ence students from around
the country gathered to at-
tend seminars on issues vi-
tal to students right now.

The delegation from
Point all agreed that it was
a great learning experience
and they have gotten some
great ideas for this campus.

Students can still call
and write their legislators
on various student as well
as univeristy issues. For
more information and the
phone number and ad-
dresses of your legislators,
stop down in the S.G.A of-
fice.

Passing down leadership duties -

Shari Davis (left), newly appointed UCAPB Chairperson, receives the gavel from her
predecessor Dee Darrow. (Photo by Nathan Wallin)

Adjunct program assists students

By Kris Wagner

NEews Epiror

The problem with put-
ting a jigsaw puzzle together
is finding the right pieces.
The UW-Steverfs Point
Reading -Adjunct program
offers the tools for students
to piece together a puzzle
with the final picture —
knowledge.

A little over 200 stu-
dents participate in the read-

ing-adjunct programs this
semester. The program al-
lows students to work in
smaller groups to discuss
class material in a variety of
ways. Some group leaders
design creative learning
games and programs, so
students can comprehend
as well as retain the infor-
mation.

According to the Coor-
dinator and creator of the
reading-adjunct program,
Dr. Alice Randlett, the pro-

gram started in 1985 with
three students in one phi-
losophy class. The program
has presently expanded to
six disciplines, 14 student
leaders, and 30 sections.
The program’s success has
led to similar programs at
universities throughout the
country.

“The growth in the last
two years has.been phe-

SEE READ ON PAGE 18
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Do you think the university should
have smoklng perlmeters"

STACEY SOLLINGER
Senior, Health Promotion

BRrIAN LYNCH
Junior, Public Adminis.

JENNIFER KIELLEY
Sophomore, Forestry

BEN BUDZIEN

Senior, English

“If youmean the 100 feet “I don’t think it could be
from buildings deal, I enforced.”

think that is wrong. Sure
smoke may bother non-
smokers, but outside?
Smokers are people, too.”

a waste

university’s money. We
should plant more trees

1”

instead!

“If it means that a shelter
or designated area would
have to be built, no. What

“One-hundred feet from the
building? I have a better
idea: Why not just kill all
the smokers. That way, the
only thing non-smokers
have to breathe in is pollu-
tion.” .

the

Point Brewery hosts festival of beers

The Stevens Point Brewery is
excited to announce the second
annual “Spring Festival of Beers,”
scheduled for Saturday, April 19,
1997 from 1:00 p.m. to 6:00 p.m.

The event, which attracted
1,000 people in its inaugural year,
is co-sponsored by the brewery,
the Focal Point Homebrew Club,
and WIZD-FM.

The Spring Festival of Beers
will be held at the Old County
Building directly across the street
from the Brewery, and will feature
more than 100 different products
from a wide variety of Midwest
brewers.

Each brewer will provide
samples of their quality beers in
an atmosphere of friendship and

mutual appreciation for craft
brewed products. Advance-pur-
chased tickets for “Point’s Spring
Festival of Beers” are $17.00 and
$21.00 at the door for adults over
the age of 21. The price includes a
commemorative Spring Festival
glass and souvenir program.

In addition to the opportunity
to sample some of the finest hand-
crafted beers, attendees will be
able to satisfy their appetites with
a variety of specialty food items
prepared exclusively for this
event.

Entertainment will be provided
by JOCK-N-A-BOX DJ service
and WIZD-FM, who will conduct
a live remote broadcast.

£
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Summer School doesn't get any better than this.l

00¥
¢ SeNieS

SUMMER Aaven Choose from
INS“TUTE courses offering university transfer

OUTOOOR AOVENTURE SRES - it i biology, physical ed/
wellness, or sociology in short term formats

Archaeology Field Trip

Sea Kayaking

Mountain Biking (3 levels)
Boundary Waters Canoe Trek

Ropes Challenge
Whitetail Deer
Northwoods Flora
Freshwater Ecology

The Nicolet College Summer Institute

-z Check out Nicolet's Regular Schedule of
University Transfer Courses being offered
during Summer Session, June 9 - August |

e 715-365-445| or 1-800-544-3039
E-mail: inquire@nicolet.tec.wi.us *  http://www.nicolet.tec.wi.us

Nicolet College, Box 518, Rhinelander, WI 54501

Profits will benefit the further
development of athletics at UW-
Stevens Point.

“We’re very excited to co-
sponsor and host the second an-
nual ‘Festival of Beers’ which of-
fers beer aficionados the oppor-
tunity to experience quality prod-
ucts from some of the finest brew-
ers in the Upper Midwest,” said
Jim Ryan, Chief Executive Officer
of the Stevens Point Brewery.

Acts

ConTINUED FrROM PAGE 1

new and exciting informationand | ¢

activities to their campus organi-
zation.

Although student leaders
searched for new information and
motivation, they were largely in-
terested in booking shows and
concerts for next year. The week-
end consisted of 39 acts that per-
formed during afternoon and
evening showcases at Sentry
Theater and The Encore.

Comedians such as Buzz
Sutherland, Elvira Kurt, and Mitch
Fatel ignited laughter, vibrating
the red carpet walls of Sentry The-
ater. Little Blue Crunchy Things,
The Invaders and Wizenhiemers
rocked the house as students
danced in the aisles and on stage.

Janet Nielsen, Assistant Pro-
duction Coordinator, commented
that, “There was a wide variety of
good showcases this year, mak-
ing it easier for programmers to
book for the upcoming school
year.”

Agents representing various
acts set up booths in Berg Gym.
The “Hollywood” Marketplace
enabled students to discuss price
and options with the performers
and their agents. Free T-shirts,

Tuesday, April 15

'+ There were 10-12 skateboarders outside the entrance of the
Fine Arts Building. They were each given a copy of the pohcy
regardmg skateboarding on campus.

-Monday,Apnl 14

~» A Community Advisor (CA) from Pray-Sims reported some

in als were destroying a bike. The bike had been run up a
g  the front end aitgnm. »

-+ Student Security Patrol re;mrted a small hole in the window
ieadmg to the hall director’ s storagc 'I‘here was no sign of van~‘
- dahsm orcrmxmal actmty

Sunday, April 13

_*An mdl_vxduai fmm Watson Hall reported agas smell commg.

Satnrday, April 12 .
~ » There was a report of a girl screammg, crying, and running
_around aimlessly. A female was found crying about a break up
| with hc'r boyfriend. Two friends accompanied the female.

Fnday, April 11
~ +Four individuals were faund in Schmeeck le Reserveandtold
:the after hours polxcy

_ An mdmduai called abaut a vehscie parked on Portage .
_with a trunk open and no one in the area. Stevens Point Police
_Dcpamnent (SPPD) was notiﬁed -

rsday, April 10

< mpiamts were made of skateboatders in front of the Um- k

caiied and requested ass

demo tapes, posters, and food
dotted the marketplace inviting
students to check them out.
NACA makes cooperative
buying opportunities with other
schools possible by booking acts
in blocks, in some cases, lower-
ing the price several hundred dol-
lars. “Because of decreasing bud-

gets, the opportunity to block with -

other schools in the region saves
those involved a tremendous
amount of money,” explained Greg
Diekroeger, Host School Coordi-
nator.

Booking acts for next year
wasn’t the only accomplishment
for host school UW-SP, but also

“ePreventian foicQ -:

the ability to pull off a successful
and fun weekend for all partici-
pants.

Gary Berg, owner/manager of
G.L.Berg and Associates, an en-
tertainment booking agency, com-
mented, “Stevens Point has al-
ways been a good location facil-
ity-wise. Greg Diekroeger and
Laura Ketchum (host school com-
mittee members) understand what
NACA is about, making it great
to be here.”

After the weekend, host
school committee member, Jason
Frey observed, “It was a success
and went smooth. Future schools
hosting this conference will look
to us as an example.”
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S 15 Minute Carryout

HOURS a or
it FAST, FREE DELIVERY

342-4242

249 Division Street
Stevens Point, WI

=

11 a.m. - 3a.m. EVERYDAY
(Reduced Hours During University Breaks)

2 I (=)

GOURMET P1zzAs TrADITIONAL PI1ZZAS
Just pick your favorite toppings. We'll pile them high
These unique pizzas are the secret to our success. and smother the whole thing in mozzarella.
After you have one, you'll never think of Thick or thin crust - same low price.
pizza the same way again. Small.......... $5.99
Small .. $7.99 BUY ONE Messamc - 9.0
ot e $10.99 PIZZA AT REGULAR PRICE - Large. . $9.99
Large ............ $13.99 GET ONE AT S 0
X-Large.... $19.99 HALF PRICE!
Taco Topper™ Torrinegs
This pgtentially messy experience starts. with taco Siballl T e 79¢ Each Topping
sauce anq is piled high with Mexican goo;lies like tortilla Medium. 5 99¢ Each Topping
chips, spicy taco meat, crisp lettuce, chilled tomatoes, Large $1.19 Each Toppin
mozzarella and cheddar cheeses. Sour cream and salsa on i oo e $1 'gg Each T p. g
the side. Voted best pizza by Topper's employees! gl D O it polabiait b
v BBQ Topper™ - Meats and Cheeses -
You'll aimost forget you're eating pizza when you Pepperoni, ham, bacon, ground beef, sausage,
try this hickory-smoked barbeque chicken feast. If you like anchovies, cheddar, extra mozzarella.
it hot, we'll add some jalapenos on request. 7
- Veggies -
X * Onions, green peppers, mushrooms, pineapple,
Big Topper™ tomatoes, zucchini, broccoli, cauliflower,
The perfect amount of ten different toppings. Pep- banana peppers, ripe olives, green olives, jalapenos.
peroni, onions, mushrooms, ham, sausage, hot peppers,
green peppers, tomatoes, etc, etc, etc.
Fajita Chicken BREADSTIX
' An open faced fajita served with Fresh from our kitchen and served with your choice of pizza
traditional Mexican sauces on the side. sauce, garlic butter or nacho cheese
Guaranteed to please your south of the border taste. = _
Single Order ........... $2.29 Triple Order ........ $5.99
' Bacon Cheddar Cheeseburger
This pizza is loaded with 80 percent lean ground DESSE
beef, real bacon and a cheddar-mozzarella blend. Your , ESSERT STIX
favorite burger toppings also available on the side. A cinnamon sweet version of our popular soft breadstix.
: Every order comes with honey, strawberry cream cheese,
' Veggie Topper™ iR e
dch filingfordipping: i o i 1.99
This pizza highlights traditional veggie toppings o g Shs ik e .
like sweet green peppers, fresh sliced mushrooms, ripe
Spanish olives and tasty whtte onions with our zesty home- :
made tomato sauce. A “ RINKS
v Ragin' Cajun Chicken Pepsi Mountain Dew
Absolutely not for the timid tastebuds. Diet Pepsi Dr. Pepper
This creole pizza is for the person who likes it HOT. Coke 5 A&W
Diet Coke Sprite
Meat Topper™ Cherry Coke Surge
R e eecglnaion of seversl RLIOHEINGD || piane . oi. 008 Eigh Six PaCkS ........ $2.99
v Four Cheese
A wonderful blend of Jack, Mozzarella, BurravLo Wines
Colby & Cheddar cheeses on our homemade tomato sauce.
x Spicy chicken wings, served with celery sticks and your
Maui Topper™ choice of ranch, blue cheese dressing or BBQ sauce.
A tropical feast without the jet lag. It's loaded with B e e $2.75
ham, pineapple slices and a sprinkle of real bacon pieces DO e $7.99
if you'd like. TEmE e $17.99
v Garden Topper™
A colorful medley of fresh hand-sliced veggies 2
including broccoli florets, juicy tomatoes, cauliflower, onion SA"A“ S
and sun-ripened zucchini.
: CardenSalat ... i s $1.99
Combo Topper™ ORISR i it $2.49
The five most popular toppings in America - on one . = . 3
pizza: pepperoni, sausage, onions, green peppers and CHOOSE ranch, italian, thousand island or french dressing.
kmushrooms, covered in shredded mozzarella.
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Weaving l’items onto a web page | THE LAT EJTSC OOF

By Dustin Overbeck

CONTRIBUTOR

In this second part in the web page series of
articles, you will expand upon the introductory
lesson from last week by adding hyperlinks, in-
serting graphics, and finally saving your web page
to the UW-SP server. (Note: if you would like to
see last week’s article, part one, see the page at:
http://www.itol.com/~overbeck/webdesign/
partl.htm)

» Adding Hyperlinks

Hyperlinks are neces-
sary in web pages to
navigate to other pages
in your web site, to link
to other sites on the In-
ternet, and to send e-
mail.

You will start by add-

ing a hyperlink to an- | — Parf Cwo —
other page in your web _
site. Remember to cre-  me—

ate this new page later since you are now making
a link to it. Begin with opening up the web page
file you created last week by selecting File>Open
File in Editor. Next type in a small line of text to
describe your link such as “Calendar of Events .”
Highlight this text by clicking and dragging the
mouse over the words and choose Insert>Link
from the programs menu. This will bring up a
dialog box asking for you to type in information
for the link. Insert “calendar.htm.” Once a

hyperlink has been made, you will notice that the
clickable area of the text is underlined.

Adding links to other web pages on the Internet is
identical to creating links within your site. After enter-
ing and highlighting the text you want to describe as
your link, choose again Insert>Link from the menu and

- insert the full web page address. For example, if you

wanted to add the link to the FBI web page, you would
insert “http://www.fbi.gov”.

Creating an e-mail link is similar to the above steps.
Simply highlight the text for the name of the e-mail link
and choose Insert>Link; type in
“mailto:pointer@uwsp.edu” (substituting, of course,
your own e-mail address).

* Adding Graphics

Graphics can be important elements in creating great
looking web pages. These graphics may be photo-
graphic pictures, backgrounds, banners, bullets, lines,
or animated pictures. Be careful not to use too many
graphics since it will take longer for people to down-
load your page.

To change the background color or to add a graphic
as a background image select Properties>Document
from the menu. By clicking on the “appearance” tab,
you will be able to select a new color scheme for the
page. .
If you choose to add a graphic as the background
image, the image will be tiled across the entire page.
The two most widely used types of graphics for the
Internet are GIF and JPG files. These will end with file
extensions “.gif” or “.jpg”. You can create your own
graphics by using the graphics program, Paint Shop

SEE WEB ON PAGE 7

UNIVERSITY CENTERS

. OP RATI

i— ""

COFFEEHQUSE/PUB

(official name to bhe determined)

The University Center is opening a newshang-out

that will be serving gourment coffee, sp%quth' be
and light snacks. The COFFEEHOUSE/E\ '
have billiards, darts and foosball.

PFPOSITITIONS OFE N

e STUDENT MANAGER (") --summer hours available--

e SERVICE STAFF (10)
ONS/PROMOTIONS COORDINATOR (1)

{i%ﬁplitétions available at Campus Activities/Student Involvement Office

Lower Level University Center.

W@ NEWS

* Fires pushed by hxgh winds engulfed parts of a tent city Tuesday,
killing pilgrims who gathered for a sacred Islamic ritual. Witnesses
report at least 300 people died and over 1,000 were injured in the inci-
dent. Exploding canisters of cookmg gas are thought to be the cause
of the fires, which bumed an estimated 70,000 tents.

TORONTO -

+ A Canadian man accused of killing has male lover while in Mexico
could face torture or possible death if he is extradited to face charges,
said the man’s lawyer. ,

An autopsy revealed that the man had drowned, but he also suf-
fered a blow to the head from a blunt object.

The justice minister requested a written assurance from Mexican
officials that the man’s safety would be protected and that he would
receive a speedy trail.

'NATIONAL NEWS

ABERDEEN PROVING GROUND, MARYLAND

* The credibility of one of the two trainees who have accused an
Army drill sergeant was called into question in court on Monday.
Defense attorney Capt. Edward Brady challenged a testimony made
by one of the accusers. This trail has branched out to a complete
mvestxgatxon af the Aberéeen we@ons-tesung and training center.

WAUKESHA
~* A mix up between two twin sxsters was cleared up Monday after
the wrong girl was arrested and jailed four nights for a crime her twin
sister allegedly committed.

Angela Staten stated in court that her sister, Sharon, stole clothes
from a Waukesha department store. Both twins presented birth certifi-
cates and Social Securtty cards to prove indentification.

MILWAUKEE

* A special committee of legxslators and educators created a pro-
posal that would allow students to attend public schools outside their
school districts, if space permits. .

The drafted proposal differs in several ways from Gov. Tommy
Thompson and state schools Superintendent John Benson’s proposal
made earlier this year.

Some of the notable issues in the proposal include a call for $1
million in vouchers to pay for the cost of transporting children from
low-income 'state residents to other school districts and a formula
that would solve the financial 1mpact on districts that gain and lose
students.

‘Tis ta);: time

A student mails in his tax return on Tuesday. (Photo by Nathan
Wallin)
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Intramurals an uneven playing field Bales urges students
Former, current players dominate champion rosters

By Mike Beacom

EDITOR-IN-CHIEF

While reading through The
Pointer sports section last week,
I came across the feature “On top
of their game;” a weekly listing
of the top intramural sports
teams.

I feel the feature has been a
great addition to the section this
year because it is nice to see in-
tramural standouts get recog-
nized along with those who par-
ticipate in Pointer athletics.

What disturbed me about last
week’s listing of block three’s
champions was that the names of
players on the title teams were
some of the same names seen
playing those respective sports at
the NCAA Division III level.

The men’s basketball cham-
pion for example, Hegemony
101, consisted of two former
standout players for Point (one of
which was a WSUC first team
selection a year ago and an hon-

orable mention the year prior to
that) and two of the team’s assis-
tant coaches. My opinion of
intramurals is that they are meant
for athletes interested in compet-
ing, yet not talented enough to
play at the collegiate level.

I do not believe former or cur-
rent players not in season should
be able to compete against those
who may have only taken their
game to the high school level or
not even that far.

What is the point of
intramurals otherwise? If people
could beat assistant coaches and
all-conference players, they
would be playing in Pointer bas-
ketball practices and suiting up
for games.

Most people do not sign up
their intramural basketball or
soccer team with the hopes of
playing against Point’s best ath-
letes. Many intramural competi-
tors play with the hopes to chal-
lenge for the sport’s title.

Unfortunately, each of the
seven intramural champion

teams for the last block contained
current or former players and or
coaches on their rosters, a total
of 17 competitors.

Intramurals instituted a sys-
tem based on talent levels for cer-
tain sports, which you would
think would solve the problem.

But looking at the non-com-
petitive co-ed volleyball “scrubs”
division, two players from this
year’s Pointer women’s squad
were on the team.

My solution is that college
athletes are not allowed to com-
pete in their respective sport, re-
gardless if the sport is in or out
of season or the player/coach has
used up his or her eligibility.

Intramurals provide an oppor-
tunity for college students to have
fun and compete. It is difficult to
compete against someone who’s
amongst the all-time Pointer
scoring leaders and it is difficult
to have fun when you can’t ad-
vance the ball past half-court.

Let the true scrubs face off
against each other.

Opening the door for others

Robinson’s contributions bigger than athletics

to recycle more

Dear Editor:

I am proud to attend UW-Stevens Point, one of the foremost envi-
ronmental colleges in the United States. Our campus is known for
being on the cutting edge of reducing waste and recycling 62% of
garbage. However I do not feel that students are making enough
individual effort to reduce waste or recycle.

How many people have seen, or actually thrown out a soda can
when the recycling bin is right around the comer? Every day, Ameri-
cans throw away enough aluminum cans to build 30 jumbo jets. How
about the student that daily purchases soda from the Pointer Express
or Taco Bell in throw away cups versus the reusable mugs? Not only
do they throw away dozens of cups, they waste money! It is cheaper
to use the mugs, and you get more soda.

The staff at UW-SP has tried to make it as easy as possible to
recycle and reduce waste by providing recycling bins all over cam-
pus and making it cheaper to reuse mugs versus throwing away cups.
About 80% of US trash currently is dumped in landfills. We have
been raised in a throwaway society, but we can break the habit by
putting forth our individual efforts to use less packaging and be more
aware of what you throw away versus what you recycle.

Jessica Bales

It claims good people.

UNTREATED

DEPRESSION

#1 Cause of Suicide

By Mike Beacom

EpiTor-IN-CHIEF

Tiger Woods could not have picked a better time
to shoot the best golf of his life or select a year to
win his first of what appears to be multiple Mas-
ters championships.

Woods became the first African-American to
win golf’s most coveted tournament on Sunday, two
days before the fiftieth anniversary of Jackie
Robinson’s major league baseball debut.

The anniversary has been built up all season
and for good reason. Robinson’s entrance into pro-
fessional baseball in 1947 dealt with much more
than the integration of baseball and professional
sports.

By stepping onto the baseball diamond,
Robinson cleared the way for other African-Ameri-
cans and minorities to enter fields and professions
of all sorts. Jackie also helped to educate human
kind about racism and the wrongs behind segrega-
tion.

His road was not an easy one and Robinson knew
it would not be when Brooklyn Dodgers’ owner
Branch Rickey approached him about the ground-
breaking opportunity.

Jackie braved all of the doubts, torments and
threats with the greatest of class. He did not retali-
ate when crowds shouted racial slurs; he simply
concentrated on the tasks at hand—being one of
history’s greatest pioneers and playing baseball.

Millions were influenced by Robinson’s efforts,
inspiring themselves to forget fear and instead per-
severe.

Robinson has influenced my life by influencing
my heroes toward greatness.

Perhaps some of you recall an editorial I wrote
earlier in the semester honoring home run king
Hank Aaron as a hero and role model of mine.
Robinson’s courage helped give Hank courage to
overtake Babe Ruth’s career home run record in a

SEE JACKIE ON PAGE 7
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or withhold the publication of
letters. Deadline for letters is
Tuesday at 5:00p.m.

Letters printed do not reflect
the opinion of The Pointer staff.

All correspondence should be
addressed to: The Pointer, 104

ADVERTISING ASSISTANT

ADVERTISING MANAGER Eric Elzen

Wade Kohlmann
ADVERTISING VOLUNTEER

Steve Schoemer
ArTs & REvViEW EpiTOoR - MCSENA T R TEE

Valentina Kaquatosh SENIOR ADVISOR

Pete Kelley
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Jackie

oo e The Pointer GET PAID FOR
g 5 33 e is Hiring SKILL TRAINI NG_

want to see Aaron do it.
Robinson was recognized
Tuesday night for his contribu-
tions. His jersey number 42 was
retired from all of baseball, an

The Army Reserve will train
you in a special skill, then let you
practice it regularly—usually one
weekend a month plus two weeks’

For the 1997-1998 School Vear.
The following staff positions are available:

Graphics Editor Copy Editors (3) \ oA
unprecedented honor, but one Photo Editor Assistant Section Editors (4) N Annual Training. : i
ell-deserved arid over-due. Photo Assrsfant Business Manager YOU'H be Well pald fOl‘ t:hls part-
w : Featwes Editor Advertising Representative (2) ti 1CO— th 318 000
Jackie Robinson may not be Sports Editor Graphics Assistant = o more, e ;
the best baseball player of all-time Outdoors Editor during a standard enlistment. And you'll have valuable
ot even-thodios PR e skill training to keep for the rest of your life.

played for the Dodgers. But one
thing is certain, Jackie Robinson
is one of the finest men to lace
up a pair of spikes and one of the
greatest leaders in American his-

tory.

Think about it. Then think about us. Then call:
If interested, pick up applications at

The Pointer office in 104 CAC. The 3 4 4'2 3 5 6

application deadline is Monday,

April 21, 1997. BE ALL YOU CAN BE

Questions: 346-2249. Ask for ARMY RESERVE

Nick or Chris K.

Web :
ConNTINVED FrROM PAGE 4 UWSP StUdentS!

Pro, or by snatching a graphic or | Super Opportunity for Fa” ]997

background from the Internet.
Paint-Shop Pro can be accessed
by going through Oriel on the
campus server and double click-
ing on “graphics/presentation

s BRI R Study Abroad Next Fall in a Place Where
opbicion e et Things Are Really Happening!
button and choose “Save Image BUild YOur Resume!

it locally, use the right-click mouse
As” to save it to your disk.

To add the graphic to your FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASHFLASH
page select Insert>Image. By typ- FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASHFLASH
ing in the name of the graphic or
by choosing the “browse” button, )

you will be able to add the graphic .
to your page.

* Saving to the UW-SP Server

If you received access last
week from the Webmaster
(webmaster@uwsp.edu), you are
now able to save your pages and
graphics to the folder assigned to
you on the web server. Using a
campus workstation, enter Oriel

and choose Internet :

Services>Internet Access>WS FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASHFLASH
FTP from the menu. This is a pro- FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASH - FLASHFLASH
gram which allows you to trans- ...AND YOUR FINANCIAL AID APPLIES!

fer files from your computer to the
server. Enter “www.uwsp.edu”
for the Host Name, your logon
name for the User ID, and then
your password. By using the two
windows inside this program you
will be able to transfer files from
your computer or disk (located in
the left window) to the UW-SP
server (shown as the right win-
dow).

Once your web page is saved
to the server, you and millions of
other people on the Internet will
be able to view it using a browser
such as Netscape Navigator. Be
sure to visit the page at http:/
www.itol.com/~overbeck/
webdesign/index.htm/ to see ex-
amples along with more hints and
tips.

Next week you will learn more
advanced techniques to further
improve your web site by creat-
ing a more advanced layout with
tables, and multimedia.

Krakow is a city of unprecedented beauty and historic value. Medieval buildings abound and the University dates
back over 600 years. Today, the history of East-Central Europe is being Rewritten. You can experience the
dramatic changes as former Soviet Bloc countries struggle tg shake off the effects of 40 years of Communism and
join the Community of Nations

UWSP INTERNATIONAL PROGRAMS * UW-STEVENS POINT

Room 108 Collins Classroom Center, 2100 Main St. * Stevens Point, WI

54481, U.S.A. *.

TEL: (715) 346-2717 FAX: (715) 346-3591

Internet/E-Mail: intlprog@fsmail.uwsp.edu & W_el-)__Sii[‘e: http://www.ggv;pfggﬁcgd/imemat/
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Tangled Reflections

Outdoors

(Submitted photo)

The group that went along with the Trippers to Texas stops along the way to pose for the camera.

Sometimes natural beauty can be found in the most unlikely of
places, like this tangled patch of brush breaking up reflections
of the late afternoon sun gleaming off the choppy surface of the

Wisconsin River in Stevens Point. (Photo by Carrie Rueter)

“Earth Day may be the turning point in
American history. It may be the
birthdate of a new American ethic that
rejects the frontier philosophy that the

continent was put here for our plunder

and accepts the idea that even urban-
ized, affluent, mobile societies are de-
pendent, with fragile life sustaining
systems of the air, the water, and the
land.”

- Gaylord Nelson, former governor, U.S.
Senator, and founder of Earth Day

[2UsTYS

-
BACKWATER ~ SALOON

Beach Party

Saturday, April 19th

Sea Cruise 9:30-1:30
$3.00 Cover Charge
Classic Rock and Beach Music
200z Taps-$1.00
200z Tropical Mixers-$2.50
Contests:
$25 Limbo
$25 Most Outrageous Outfit
$50 Hunks in Trunks
$100 Bikini Contest

*Also—Sign up for Volleyball-League Forming Now

Rusty’s is Located S miles West on HWY P
then 1/2 mile South on West River Drive

341-2490

Trippers’ Spring Break journey

By Susan Ermer
CONTRIBUTOR

Once again the Trippers took
off for spring break. The main
goal of this year’s trip was to avoid
SNow.

We figured Texas would be far
enough. A 28 hour drive to the

Guadalupe mountains sounded

great.

We stopped at Carlsbad Cav-
erns in southeast New Mexico on
the way down. It was very beau-
tiful. I recommend it to anyone.

Once we got on to the
Guadalupe Mountains, we were
fortunate enough to view the lu-
nar eclipse (although some of us
couldn’t stay awake past 9:30 and

missed it) and the comet over the

flat desert of Texas.

The hike started with a rough
climb up 2500 feet to the first camp-
sites. The trails were all rugged
and followed along by beautiful
scenery.

Planetarium features famous comet

we couldn’t avoid the snow.

The nights got pretty cold. A
couple of the mornings we were

woken by snowflakes hitting our

tents.

Why is it a person can spend
their whole life in Wisconsin and
when they leave the snow always
seems to follow? Even in Texas,

=t

The Guadalupe Mountains
offer great diversity, from the
Prickly Pears of the desert to the
Ponderosa pine of the forest. We
were able to live through the
snow, the heat, the winds and the
rain.

It is Americaall in one.

Hale-Bopp holds center stage,for extended serie§

Have you seen the comet?

That’s a question you will be
hearing more often as the comet
Hale-Bopp grows steadily
brighter and higher in the sky.

“It’s the comet of the century,”
according to Randy Olsen, UW-
Stevens Point Planetarium and
Observatory director.

The current show at the
UWSP Planetarium, which fea-
tures Hale-Bopp, has been ex-
tended to run through May.

The program, “Comets are
Coming!,” shown on Sundays at
2 p.m., is free and open to the pub-
lic.

With the popularity of the
show growing, people are occa-
sionally turned away from the first
show, but a second show may be
run.

When skies are clear, Hale-
Bopp is very bright in the north-

western sky and it will be visible
throughout the Spring. The comet
is more than 1.5 million miles long,
travels faster than 90,000 miles per
hour and is predicted to become
brighter than Halley’s comet.
Regarded as evil omens dur-
ing ancient times, comets have be-
come valuable scientific tools in
understanding the universe.

Information about other com-
ets will be presented at the show,
including a review of comet Shoe-
maker-Levy 9, which smashed into
Jupiter in 1994.

On Mondays, a program
about “The Skies of Spring” is run
at the Planetarium at 8 p.m.

The program is free and open
to the public.

On clear nights the observa-
tory will be open to viewers fol-
lowing the program.

On Tuesda); evenings, a light
show featuring the music of Pink
Floyd isrun at 8 p.m.and 9:30 p.m.
There is an admission charge of

‘$2 for the public and $1 with a

UWSP student ID.

The program that was sched-
uled to begin in April, “The (New)
Mars Show,” will be postponed
until summer. By then, two un-
manned missions to Mars will be
in the news.

Pathfinder is scheduled to land
on the planet’s surface in July.

The Global Surveyor Mission
will photograph the entire surface
of the red planet beginning in Sep-
tember.

A new laser light show will pre-
miere this summer as well.

Groups of 15 or more should
call ahead for reservations, at (715)
346-2208. There is acharge of $15
per group for these presentations.
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I’'m not exactly an outdoors hound, but every once in a while I
motivate myself off the couch, out the door and into the wilderness
Wisconsin has to offer.

Last summer my roommates and I set a Saturday aside to chal-
lenge the Wolf River on a rafting expedition. I’m ashamed to say it
was my first trip floating down stream on any craft.

Heading into the event, I pictured rugged waters like the ones
from the film “Deliverance” crashing through our floating device as

Mike Beacom
EpITOR-IN-CHIEF

visualize a forthcoming experience.

Although the brisk waves of the Wolf did not have our group of
six clutching onto the sides of our rafts in fear for our lives, they did
cause a few of us to wipe our brows in relief.

The six-hour “Shotgun Eddie’s” tour only lasted five because
we chose to set out further downstream in order to dock before sun
down.

We encountered four drops on the trip; the final being more than
a ten foot plunge. Not being an expert on paddling through the
heavy rocks past the drop-offs, I am proud to say my partner and I
never tipped.

Where I did tire was on the long flat runs where the river forced
me to paddle for hours at a time. I never imagined being out of shape
would put a slight damper on a rafting trip.

We used the extra time between drops to sip en a bottle of Cap-
tain Morgan’s and discuss how we were going to make our troubles
sound dangerously extreme when we met up with the other two
rafts.

[ cannot remember another time in my life when I was as nervous
and at the same time juiced up with adrenaline as when we braved
the final drop.

Both rafts before us tipped and were probably pessimistically
waiting for our attempt to hurdle the intimidating obstacle. But we
made it, giving me a sense of both accomplishment and relief.

It may have been my only outdoor adventure last year, but
rafting the Wolf made up for a year in front of the television.

A return trip is already one of my top priorities for the upcoming
summer and I will be eagerly awaiting the final drop.

Once I again I feel like I should remind all of you out there that this
column is intenided to reflect on your experiences, not just those of
us on the staff of this paper. So if you feel like you could handle it,
how about composing for me a two page essay on anything you’d
like, as long as you did it outdoors? Just email it to me at
nkatz350@uwsp.edu, or drop it off at the office here in the Comm
building, room 104. ;

Nature News and Notes

» Becoming an Outdoors Woman (BOW) is sponsoring its first
workshops of the season April 19 and 20 in southeastern Wisconsin.
The workshops offer an excellent opportunity to learn hands-on in a
relaxed environment. Special student rates: Upland bird workshop-
$15, Fly Fishing workshop $15. Call 346-4151 for information or just
stop in and see Beth Hurst in CNR 245.

* The annual spring crane count is set for Saturday April 26. Come
help scout out breeding pairs of sandhill cranes. There will be two
informational meetings- Monday April 14 and Tuesday April 15 in
CNR 170 at 6 p.m. Just attend one of the meetings to sign up for the
count, where you will receive a site and a map. If you have questions
or can’t attend either of the meetings, contact Ann at 346-2511, Gina at
346-6129, or the TWS office at 346-2016.

* Ian McHarg, author of Design with Nature, will be the keynote
speaker at a conference on “Managing Community Growth through
Sustsainable Design,” Saturday, April 26 in Madison. This conference
will be free to students. Dr. Brush will be driving a van leaving at 8 a.m.
and returning at 8 p.m. See the good doctor for details.

« Schmeeckle Reserve will host an open house for the public free of
charge following the induction ceremony.

* An expansion of the Richard 1. Bong Memorial Airport in Supe-
rior is the first site to be proposed to receive authorization for the
“incidental taking” of endangered and threatened species under a
new state law enacted last year. Under the law, the DNR can authorize
taking endangered or threatened species from a location if that re-
moval won’t jeopardize a species’ survival or recovery in Wisconsin.

By Charlie Sensenbrenner

we struggled to swim ashore- I tend to be melodramatic when I |

: weight in the minds of students

Conservation Hall of Fame to
host induction ceremony

nents in Wisconsin’s environmen-
tal heritage.
Aldo Leopold,

the initiative of another inductee,
Fred Schmeeckle.

Gaylord Nelson, a former Wis-
consin governor and one of the
few living inductees, came up
with Earth Day as an official holi-
day.

In order to be inducted, a nomi-
nation must first be submitted to
the hall’s Board of Directors.

After that they must be unani-
!| mously approved by that same

board which is headed by Earl
Spangenberg, and consists of
22 extremely diverse state orga-
nizations ranging from the Wild-
life Federation to the Wisconsin
Bowhunters.

The hall itself, which adjoins
the Schmeeckle Visitor Center, has
scheduled a grand opening in the

Outpoors Epitor .
inducted

twelve years ago with John Muir

On Saturday, Fred G. Wilson,
Henry Leibzeit, William
Peterburs, and Jacob Bruecher
will be inducted in the Wiscon-
sin Conservation Hall of Fame
with a ceremony at the Sentry
World Theater. / }

Wilson was the state’s sec- |
ond forester, Leibzelt was largely |
instrumental in passing stronger \
hunting and fishing regulations,
Peterburs initiated a ban on lead
shot, and Bruecher used his en-
vironmental law practice to fight
against pollution.

Their names carry as much

in the hall’s inauguration, is
widely considered “the father of
conservation.”

Our College of Natural Re-
sources would not exist without

as listings in the campus directory
but all, along with the 29 previous
inductees, were integral compo-

SEe HALL ON PAGE 13

The tail of this wolf will twitch and a narration with the voice of a Native American will explain the
exhibit to visitors next year in the Conservation Hall of Fame. (Photo by Carrie Reuter)

Ten more good reasons to live at the Village*
(*Some of which are absolutely true)

41. You're right there on the coast of Spain! (Sorry: That's a reason to
live in a villa.)

You can work for a portion of your rent. i ;

Our fitness center and game room are open seven days 4 week.

We let you request your unit on a first-come, first-served basis.

Your suggestions are appreciated, not’ 1gnored

Our maintenance man can lift a Volkswagon by himself.

We're just off the Green Circle.

If you need a roommate, we'll help you find one.

We have trivia contests in every newsletter.

All during Finals week: All the chutney you can eat!

VILLAGE APARTMENTS

It's your life. Live where you want.

42
43.
44,
45.
46.
47.
48.
49.
50.

Call 341-2120 for a tour.
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Pointers’ seventh inning surge still short
Three runs not enough to grab sweep over Whitewater

By Nick Brilowski

CONTRIBUTOR

The Pointer women’s
fastpitch softball team came
within an eyelash of pulling off'a
two game sweep of ranked con-
ference foe UW-Whitewater at
home Tuesday afternoon, but in-
stead was forced to settle for a
split.

In the conference openers for
both squads, UW-Stevens Point
used the long ball en route to a
8-3 victory in the first game and
then saw a seventh inning rally
fall just short as the Warhawks
escaped with a 5-4 win in the
nightcap.

“We should have won both
games. We made some mistakes
we shouldn’t have made at this
point of the season,” UW-SP
women'’s fastpitch softball coach
Dean Shuda said.

“In the first game, we over-
came them with good hitting, but
in the second game we dug too
deep of a hole for ourselves,”
Shuda added.

Already trailing 2-0 in the
opener, the Pointers mounted a
four run rally in the bottom of the
third, highlighted by a three-run
Kelli Harms home run over the
fence in center.

The Warhawks cut the lead to
one with a run in the fifth, but
Stevens Point answered again
with three runs later in the in-
ning. The long ball again was
the key to UW-SP’s success, with
a two-run blast by Charity
Czappa and a solo shot by Jenny
Mathiak.

The Pointers added an insur-
ance run in the sixth to account
for the final margin.

Jill Kristof ripped three hits
while Jamie McDonald got the
mound win and Becky Prochaska
picked up the save.

Game two saw Whitewater
jump on Pointer starter Jamie
Lowney for two runs on three hits
in the top of the first to get the
early advantage.

(Photo by Nathan Wallin)

The Pointers’ Jenny Mathiak shows her sweet swing with her
fifth inning home run off Whitewater's Terry Bierbaum. UW-
SP went on to win the opener of the doubleheader 8-3.

Point cut the lead in half in
the bottom of the second when
Kari Rowekamp led off with a
double and Czappa knocked her
home to make the score 2-1.

Whitewater collected single
runs in the fourth, fifth, and sev-
enth innings to take a seemingly
insurmountable 5-1 lead into the
bottom of the seventh only to see
the Pointers mount a late charge.

With one out, Czappa walked
and pinch-hitter Becky Chase
and Jen Mathiak followed with
singles to load the bases.

Michelle Gerber’s ground out
scored Czappa to cut the lead to
5-2.

Medicine balls to footballs

Joel Hornby_passes a medicine ball to a teammate in the
Pointer football team’s spring drills. (Photo by Nathan Wallin)

Pinch-hitter Allison Hoseth
then came up with two outs and
provided a huge two-run single
to cut the lead to 5-4.

Harms followed with another
single to bring the tying run into
scoring position, but Erika
Hunzinger flew out to center,
ending the rally.

“Some people consider
Whitewater to be the best team
in the Midwest. I think there is
no doubt we can play with them,”
Shuda said.

The split brought the Point-
ers record to 8-10 overall and 1-
1 in the WWIAC, while
Whitewater went to 17-3 and 1-
1 respectively.

Baseball rallies to salvage
split with Marian

By Ryan Lins

AssISTANT SporTs EpiTOR

The UW-Stevens Point base-
ball team traveled to the friendly
shores of Lake Winnebago last
weekend for the Oshkosh Tour-
nament to face state powerhouses
UW-Oshkosh (10-2) and St.
Scholastica (21-4).

The Pointers then returned to
University Field Monday to face
Marian College (6-10-1) in a
home doubleheader.

On Friday, UW-SP started its
weekend on a good note with a
12-5 win over St. Scholastica.

Despite falling behind 2-0 to
the Saints, the Pointer offense
came alive in the fourth inning.

Designated hitter powerhouse
Gary Kostuchowski started the
inning off with a double, and
Chris Berndt followed with a
walk.

With two on and one out, third
baseman Scott Mueller stepped
up to the plate and drilled a three

run homer off Saints’ pitcher Jay
Milbriage to give the Pointers a
3-2 lead.

From then on, the evening
only got worse for the St.
Scholastica hurlers.

In the sixth, the Pointers
smoked both Milbriage and re-
liever McLeod for seven runs off
three hits, five walks and a
ghastly six errors.

Mueller’s bat led the UW-SP
offensive attack. He was 2-4 with
three runs scored and four RBIs
on the day.

On the mound, Ryan James
(3-1) pitched six strong innings
of work, giving up six hits, four
runs, and striking out six for the
win.

The opening win set the stage
for a tussle with conference rival
and the #1 team in Division III,
UW-Oshkosh.

The Pointers trailed the Titans
4-2 going into the bottom of the

SEE BASEBALL ON PAGE 13

Jesse Ray follows through on his delivery in the opener®of the
Pointers’ doubleheader Monday. (Photo by Nathan Wallin)

'scormgwnﬂi 36pomts(23 goals, - added
13 assists), the Pa!mer, Alaska
native was named to the Ameri-

Pomters‘sconng machine duﬁng

is looked at by
the best offensive
> nation and ‘maybe
tl:e best ovem!l player as well.
“We feel if he had four

~ years here, he would have had a
shot at breaking a lot of people’

records,”. Baldnrotta said.




By Mike Kommeter '
Sronrs Epiror

After a disastrous first five months of the Natlonal Basketball
Association season, the Milwaukee Bucks guaranteed themselves
a spot in the draft lottery for the sixth straight year. But now that
they have absolutely nothing to play for, the team suddenly put
together a three game winning streak w:th only two weeks of the
year left.

Sure, it has been said in the past that teams should end their
season on a high note to build on for the next year, but the Bucks
have lost valuable ping pong balls in the lottery by putting together
what should be called a meaningless winning streak. .

Going into their pointless streak, they had 29 wins on the year,
which could have glven them the eighth slot in the lottery. But
now they have 32 wins and find themselves in the tenth spot, just
one win “in front” of Sacramento. .

People will say that it is more important to win games, but
those victories will cost the Bucks a better player in the draft.

What looks better in the long run, a little winning strxng ora
more talented player who can help the team win for years in the
future?

Milwaukee, even at the eighth spot, definitely doesn’t have the
odds in their favor to jump into the number one slot or much less
the second or third when the ping pong balls are .

However, dropping from eighth to tenth could cost the B ks
dearly once the order is detennmed If ateam beiow Mtlwauk m'

stars leave after their second year, i

by how many kids come out.
It is much like that this year, whe
dramat:caﬂy after the ﬁrst seven or

guard or a big man good enou
next year with the tenth pick? ,

Yes, these three wins were agamst'
beat if they considered themselves a
start of the season. But the season
d:sappomtmem, iosmg’:othesa« ,
once again returning to the lottery.

- Milwaukee should have p
were out of playﬁff contention, because ey
since could aid in robbing the Bucks’ future c

L AR SRR SR R B S SRR
On top of their game

Intramural Top Teams
Men’s Basketball Top 10

1. Caucasian Persuasion 6. Italian Brown Stars
2. NBA 7. Joe Drae’s Farewell Tour
3. The Posse 8. Greg Hacker’s Team

4. TAPPI
5. Beer Guzzling Jerk Offs
Women’s Basketball Top 5

9. Choir Boys
10.Morning Wood
Co-ed Volleyball Top 5

1. Freedom 1. Last Chance Again
2. LotD 2. TAPPI

3. Hoochie Mamas 3. Spank

4. 1428 4. D’s Destroyers

5. TakeFive 5. Coyote Roadhouse
Men’s Volleyball Top 3 Women’s Volleyball Top 3
1. TAPPI 1. Wild Hunger

2. Misfits 2. Urbs

3. Pack 3. Green

Floor Hockey Top 3 Soccer Top 3

1. Beck’s Bruisers 1. The Little Rascals
2. MPS. 2. Surge

3. Blue Palookaville
Ultimate Frisbee Top 3
1. Gravitrons

2. Spliffenhauk

3. The Cassady’s
Softball Top 3

1. The Calvary
2. TAPPI

3. Cheese is Good 3. The Flying Crows
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Snow forces track team to Oshosh‘

By Joshua Morby

CONTRIBUTOR

The UW-Stevens Point
women’s track and field team had
a little change of plans Saturday.

The Pointer squad was sup-
posed to travel to Whitewater for
the Warhawk Invite. However, -
the meet -was snowed out, and
UW-SP was forced to participate
in a small meet at UW-Oshkosh.

The Pointer women’s team

‘ finished second in a three team

triangular against UW-Oshkosh
and UW-Parkside.

After starting the meet out-
side, many events were forced in-
side due to Mother Nature.

As a result, some of the dis-
tances were shortened and the
throwing events were canceled.

“Because of all the sudden
changes the meet was rather low
key which turned out to be an ad-
vantage. The team just relaxed
and got after it,” UW-SP
women’s track and field coach
Len Hill said.

Jessie Bushman, with a time
of 26.24 in the 200 meters,

nabbed one of the two first place
finishes for the Pointers.

Katie Eiring continued to im-
prove in the pole vault, leaping
10°7", setting the school record.

Both Pointer teams will host
their only outdoor meet of the
season Saturday at Coldman
Track beginning at 11 a.m.

B The only time this
team has been
together was for

the team picture.

7

-Armon Gilliam, forward on the Milwaukee Bucks, on the Bucks’

team chemistry this season.

Sports Illustrated

Supervisory Positions Include;

Intern/Co-Op
Opportunities

Desktop Publisher (filled)

Office Supervisors (1 open)
Production Supervisors (filled)
Distribution Supervisors (4 open)
Traffic/Logistics Supervisor (filled)
Warehouse Supervisors (filled)
QA Lab Technician (filled)

Figi's Human Resources

Attn: Ron Herman
2525 Roddis Avenue
Marshfield, W1 54449

Fax (715) 384-1177

Time Is Running Out | Only a few Positions Left |

Don't miss your chance to set yourse|f apart !

Employers Look for Leadership Experience |

Figl's Gifts, Inc., a teading direct mail marketer of food gifts and
specialty items located In central Wisconsin, has a unique internship
program for the fall semester of 1997.

This opportunity involves a learning period, paid supervisory tralning,
followed by hands-on supervision of 20 to 100 seasonal employees.

These positions, located in Marshfield & Stevens Point are
open to all majors. Figi's prefers students with solid communication
skills, computer familiarity, a positive attitude, and the desire to learn
how to supervise people.

These Positions Offer:

40+ Hours per Week !
Hourly rate of $7.76 |
- Extra $325/month for Housing !
Paid Supervisory Training !
Friendly, team atmosphers.
Chance to make valuable contacts!

To find out more, contact Figl's Human Resources office at 1-800-360-8542,
or by faxing a resume and brief cover letter to the following address:
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Defense sure to dominate first round of NFL draft

By Mike Beacom and Joe Miller
EDITOR-IN-CHIEF CONTRIBUTOR

This weekend’s National Football
League draft should witness a flock of
underclassmen selected in the opening
several picks and first round. Since Ten-
nessee quarterback Peyton

but since Baltimore picked up Seattle’s
Michael McCrarey, a trade is likely.

- 5) Lions—Detroit would have pre-
ferred Springs but will settle for Texas
cornerback Bryant Westbrook.

6) Rams—If St. Louis is unable to
trade up and if the top five picks hold true,
the Rams will take FSU tackle Walter

Manning opted to stay in
school for his senior year,
Ohio State offensive line-
man Orlando Pace has
taken over the role of most
desirable college prospect.

New York Jets head
coach and general man-
ager Bill Parcells was hot
for Manning, but might
balk at the chance to take LOMESPN*

When: Saturday, 11 a.m.-
6 p.m. on ESPN, 6-9 p.m. on
ESPNZ. Sunday, 10 a.m.-6p.m.

Jones.

7) Giants—Colorado
wideout Rae Carruth
seems like the logical se-
lection with New York
longing for offensive
help.

8) Buccaneers—The
first of Tampa Bay’s first
round picks might be a
stretch in lowa corner
Tommy Knight.

Pace leaving Parcells with the option of
selecting someone else or trading the pick
to someone desperate for Pace’s services.

Draft Order (First Round Only):

1) Jets—New York’s defensive side of
the ball has more holes than swiss cheese.
If Parcells can’t find a decent trade offer,
he’ll select USC’s Darrell Russell (DT).

2) Raiders—Oakland traded up into
the number two slot for Pace and unless
someone moves in front of them, Pace will
be wearing silver and black next season.

3) Seahawks—Ohio State will be the
college of choice two picks in a row as
Seattle, who desperately needs a
cornerback, will select Shawn Springs.

4) Ravens—At first, Florida State’s
Peter Boulware seemed like a lock here,

9) Cardinals—With their linebacking
cogps in rough shape, Arizona will take
Alabama’s Dwayne Rudd.

10) Saints—New Orleans’ running
game was nonexistent a year ago.
Houston’s Antowain Smith should help.

11) Falcons—FSU’s Reinard Wilson
should bolster the defensive line.

12) Seahawks—Pick twelve is way too
high to select a quarterback, so Seattle will
improve the offensive Tine first-Tarik
Glenn, California. :

13) Oilers—Yatil Green of Miami will
give a lift to Houston’s wideouts.

14) Bengals—Jamie Sharper will im-
prove the Bengals’ linebacker unit.

15) Dolphins—Miami may decide to
trade this pick for extra selections. If the

Dolphins keep this pick they should take
Columbia defensive end Marcellus Wiley.

16) Buccaneers—Tampa will improve
their running game by taking FSU’s
Warrick Dunn here.

17) Redskins—Renaldo Wynn should
add some size to Washington’s ‘D’ line.

18) Cowboys (in trade with Chiefs)—
Dallas will select linebacker James Farrior
from Virginia, even though the Cowboys
hinted at-drafting a receiver.

19) Colts—Badger fans will be thrilled
when the Colts reserve their number 19
pick for tackle Jerry Wunsch.

20) Vikings—Minnesota’s luck with
running backs has been as good as Dallas
players’ luck with drug tests. Hopefully
Washington back Corey Dillon will turn
out to be a positive addition.

21) Jaguars—California tight end
Tony Gonzalez will be a faverite target in
the future for Mark Brunell.

22) Eagles—Philly is another ball team
in need of linebackers. Outside backer

Jason Taylor of Akron will be the pick for
the Eagles here.

23) Bills—With retirement of Kent
Hull at center, Buffalo will fill the need
with Rod Payne from Michigan.

24) Steelers—Pittsburgh will concen-
trate on improving defense and will notch
defensive end Kenny Holmes of Miami.

25) Chiefs (in trade with Cowboys)—
Kansas City will fill a void at tight end
with David LaFleur out of LSU.

26) 49ers—San Fransisco may drop
out of the first round. But if they keep pick
26, Virginia Tech’s Jim Druckenmiller
will be brought in as a replacement for
quarterback Elvis Grbac.

27) Panthers—Carolina will draft a
Miami wide receiver here, but the ques-
tion is, which one? Reidel Anthony should

get the nod over Ike Hilliard.

28) Broncos—Nebraska cornerback
Michael Booker will aid in the secondary.

29) Patriots—Dexter McCleon, cor-
ner, will work well opposite Ty Law.

last forever).

or Miami’s Kenard Lang.

. 3
ker r r Wolf
The Packers hold picks in each round and two in the last round. Ron Wolf
will look for a linebacker and if the player is right, a defensive end (Reggie won’t .

What to expect...Even though Green Bay needs an outside linebacker, the
top ones will be gone by the 30th pick. Wolf has not said anything about moving
up or down in the draft and usually he doesn’t go back on his draft intentions.
Green Bay will probably go with a defensive end, either Clemson’s Trevor Price

Don’t be surprised if...the Packers use their third or fourth round selection
to replace return man Desmond Howard.

Pick #s, Round #...30 (1), 60 (2), 90 (3), 126 (4), 160 (5), 193 (6), 231&240 (7).

WEeEk Iv Poinr!
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THURSDAY. AF
Men's VB, Club;

Dept. of Theatre & Dance Prod.: THE SECRET RAPTURE,

7:30 PM (JT-FAB)
TREMORS Dance Club, 9PM (AC)
SUNDAY, APRIL 20

Men's VB, Club National Tourn. (Tucson, AZ)
SB, Milw. Sch. of Eng. (Parent's Day), 1PM (H)

Planetarium Series: COMETS ARE COMING, 2PM (Sci. Bldg.)

Suzuki Voice & String Students Festival Recital, 2PM (MH-FAB)

Central Wisconsin Symphony Orchestra, 7:30 PM (Sentry)

MONDAY, APRIL 21- EARTH WEEK & SEXUAL ASSAULT

AWARENESS WEEK

Rec. Serv. HAPPY HOUR, 3-7PM--FREE Popcorn & Soda; 20%
OFF Indoor Games (Rec. Serv.-UC)

Rec. Serv. Backpacking Mini-Course, 7PM (Rec. Serv.-UC)

Planetarium Series: SKIES OF SPRING, 8PM (Sci. Bldg.) _

TUESDAY, APRIL 22 g

SB, UW-Oshkosh, 3PM (T)

Rec. Serv. Wilderness Survival Mini-Course, 7PM (Rec. Serv.-UC) .

Centertainment Prod.-Issues & ldeas Mini-Course: BALLROOM
DANCING, 7-9PM (Laird Rm.-UC)

Student Composers Concert, 7:30 PM (MH-FAB)

Schmeeckle Reserve: Of Trcefrogs & Timberdoodles, 7:45-9:15 PM

RIL

Men’sVB;Ctith National Tourn. (Tucson, AZ)

Baseball, UW-Platteville, 1PM (H)

Dept. of Theatre & Dance Prod.: THE SECRET RAPTURE,
7:30 PM (JT-FAB)

UWSP Opera Performance, 7:30 PM (MH-FAB)

Centertainment Prod.-Special Events Presents: THE FLAMING
IDIOTS (Jugglers), 8-9:15 PM (Encore-UC)

TREMORS Dance Club--Disco Fever, 9PM (AC)

SATURDAY, APRIL 19 : .

Men’'s VB, Club National Tourn. (Tucson, AZ)

Suzuki Marathon, 9AM-12N (MH-FAB)

ACT HUNGER CLEAN UP ‘97 w/Kick-Off, 10AM (South Dining
Rm.-DC), 10AM-2PM

Schmeeckle Reserve: Wis. Conservation Heritage Induction

Ceremony Luncheon--$10, 10AM-12N (The Restaurant) (Visitor Center)
TR, Coleman Invite, 11AM (H) Planetarium Series: LASER LIGHT SHOW, 8&9:30PM (Sci. Bldg.)
Baseball, UW-Oshkosh, 1PM (T) WEDNESDAY, APRIL 23

E UWSP Opera Performance, 3PM (MH-FAB)
SB, Carthage, 3:30PM (H)
Central Wisconsin Symphony Orchestra, 7:30 PM (Sentry)

SOURCE & Campus Act./Stu. Inv. Workshop: PASSING THE
GAVEL WORKSHOP, 6PM (Alumni Rm.-UC)
Jazz Lab Bands & Jazz Combo Concert, 7:30 PM (MH-FAB)

For Further Information Please Contact the Campus Activities Office at 346-4343.

20000009 D00
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fifth before coming up with two
runs, tying the game at 4-4.

Mueller again led the charge
for UW-SP with a two-run single
that scored Ryan Krcmar and Ja-
son Vande Berg.

Unfortunately for the Point-
ers, that was all the offense they
would get on the day.

The Titans opened up the
game in the sixth and seventh
innings with six runs off starter
Adam Adamovich and reliever
Matt Cotter to give UW-Oshkosh
a 10-4 victory.

The loss gave the Pointers a
split at the Oshkosh Tourney, and
also snapped Kostuchowski’s fif-
teen game hitting streak.

On Monday, the Pointers
needed a rally in the bottom of
the seventh to salvage a split
against Marian College.

In the first game of the
twinbill, UW-SP fell behind 5-0
after the first and never recov-
ered, dropping the 14-10 opener.

The Pointers’ sluggers were
led by Mueller (3-4, 3 RBI), and
Kostuchowski (2-4 2 RBI).

UW-SP pitchers Justin
Duerkop and Jesse Ray watched
the fireworks overhead, giving up
14 runs on 11 hits.

In the second half of the
doubleheader, the Pointers es-
caped with a 8-7 win after allow-
ing three runs in the top of the
seventh.

Entering the bottom of the
seventh with a 7-7 tie,
Kostuchowski’s single drove in
Thom Steger and the winning
run with two outs.

UW-SP pitcher Chris
Simonson left the game after six
strong innings of work with a 7-
4 lead.

Tony Austreng (1-1) picked
up the victory in one inning of
relief despite giving up three runs
on three hits.

The Pointers take the dia-
mond Friday at home ina WSUC
doubleheader against UW-
Platteville and travel to UW-
Oshkosh Saturday.

2% miles North of the Square on Second Street
Stevens Point * 344-9045

Presents...

Friday, April 18
Black Helicopter

Alternative Rock

Saturday, April 19

Burn’t Toast & Jam
Bluegrass Rock

Specials Tue + Wed $1 off micro
brews. Thurs $1.50 off pitchers-$1
bottles of Point, Bud + Miller
products. $1 rails and rail shots.
Find admission discounts & band info
hgp://www.wmdcs.com/~rborowy

Hall
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Spring of 1998 with a mission “to
encourage the growth and prac-
tice of a conservation ethic as a
legacy for the people of the state.”

Multimedia exhibits, such as a
tail twitching timber wolf stalking
a ruffed grouse through a 17th
century forest of virgin pines,
has thus far and will continue to
be constructed primarily by UW-
Stevens Point students and fac-
ulty members.

Most of the work will be done
during the school year, so time
presents a major obstacle. “I

won’t be teaching as many
courses next year so that I’ll be
able to spend more time out here,”
said Ron Zimmerman, director of
Schmeekle Reserve. “It’s an enor-
mous project, but I think we’re up
for the challenge.”

Currently, wooden plaques
featuring the names, the likeness,
and inspirational quotes from
each of the members hang across
asingle wall facing a scenic view
of the reserve.

However, graduate student
Robert Steele is in the process of
campiling biographies on the
enshrinees with hopes of bring-
ing them to life in the visitor’s

eyes and thereby making the dis-
play more dynamic.

“It’s kind of amazing how in-

terconnected they are,” said
Steele. “They had their own
means of action and limitations
based on their occupations, but
they all had a passion for the out-
doors and a belief that something
had to be done.”

Some, such as Nelson with his
heavy influence on both state and
federal government, accom-
plished their goals directly.

Others were more discrete.
Walter Scott “accidentally” lef*
information about an ignored
source of pollutlon for a reporter
to find on his Department of Natu-
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ral Resources desk. Nearly all the
hall’s members were personally
connected. :

Aldo Leopold wrote a letter of
recommendation for fellow in-
ductee Wallace Grange and fre-
quently corresponded with former
students Fred and Francis
Hammerstrom.

In A Sand County Almanac,
Leopold wrote, “We abuse the
land because we regard it as a com-
modity belonging to us. When
we see land as a community to
which we belong, we may begin
to use it with love and respect.”

If he were able to walk through
the Hall, he’d have to admit we’re
heading in the right direction.

© Visa U.S.A. Inc. 1997

Becalse today is
mystery meat day.
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By Lisa Nellessen-Lara
CONTRIBUTOR

On almost all college cam-
puses students are given the op-
portunity each year to take part in
many student organizations.

These organizations are estab-

lished to focus on certain areas of

study to provide real life work ex-
perience for the students before
graduation.

' UW-Stevens Point is privi-
leged enough to offer a large vari-
ety of organizations for their stu-
dents, representing several ma-
jors.

One of the most visible orga-
nizations on campus is SVO, a
completely student run television
broadcasting station that offers
students a chance to get involved
in broadcasting.

“Students are able to learn the
introductory level of television
and production through SVO,”
explained Josh Wescott, SVO
news director.

“They are able to learn what
goes on behind the scenes,” he
added.

Not only are students able to
get involved, but the Stevens
Point community is given the
unique experience of working to-
gether with the students.

Students from any major on
campus, as well as members of the
community, are encouraged to

take part in the production of
SVO.

“When [ started volunteering
at SVO I knew nothing at all about
television production. Now | am
able to run the control room
alone,” claimed Gordon Scott, a
volunteer from the community.

Scott was asked by a friend to
help her with a show a year and a
half ago and stayed on after the
project was completed.

Twelve positions are open
each year to students wanting to
get involved. All hiring is done
by the student executive staff of
SVO.

“Decisions for the 1997/1998
school year have not been made
and SVO is still accepting appli-
cations,” said Bryan Oechsner,
commercial producer at SVO.

The student station is broad-
cast on Channel 10 through
Marcus Cable. It is available on
campus and in the communities
of Stevens Point, Plover and Park
Ridge. The station is able to reach
35,000 to 40,000 viewers.

“The station offers the com-
munity a chance to see what the
university is doing,” claims
Wescott.

SVO offers programming from
4 p.m. to 10 p.m., Monday through
Friday.

They offer UW-SP produc-
tions such as SVO local news, Fi-
nal Cut and Watson’s Brew.

Featares

Carrie Reuter)

Todd Kleparski, editor, works his magic in the SVO television studio Tuesday night. (Photo by

Final Cut features movie re-
views by student movie critic
Mark Krawcyzk. Watson’s Brew
is a news variety show that airs
Fridays at 5 p.m.

The station also offers musi-
cal programming. People can tune
in to see such shows as Metal
Thunder, Video Country, Urban
Rhythms and Saucy videos.

SVO also has access to other
campus productions like Burly
Bear, which is produced in Con-
necticut.

Sports fans are not left out of
the station’s programming. Stu-
dents are also able to watch
Pointer hockey and men and
women’s basketball home games
live.

Gesell Institute celebrates 25 years

By Tara Zawlocki

CONTRIBUTOR

The Gesell Institute for the
Study of Early Childhood on UW-
Stevens Point’s campus marked
its 25th anniversary last Sunday.

The institute, named for the
late Arnold Gesell, is a teaching
laboratory dedicated to the study
and service of young children and
university students.

Its programs provide univer-
sity students with the opportunity
to gain experience in working with
young children.

According to their mission
statement, the goal of the insti-
tute is “to create a model environ-
ment which is structured, safe and
responsive while providing a fo-
cused and structured experience
for future teachers.”

The event, which held the
theme “Touching the Future for
25 Years,” featured a dedication
ceremony honoring the facility
and those who have played an im-
portant role in its success.

Many students and faculty at-
tended the event honoring the
Gesell Institute.

Children’s activities and a
scholastic book fair to benefit the

A student takes advantage of Gesell's laboratory with the help
of a little friend. (Photo by Carrie Reuter)

Gesell Scholarship account were
also offered.

UW-SP students also partici-
pated in the event by interacting
with the children present.

The program’s co-directors,
Terese Baier and Catherine Howe,
believed the anniversary was an
important milestone.

According to Howe, “The
Gesell Institute has remained
strong and we wanted to make

certain it was recognized on its
25th anniversary.”

UW-SP junior Margaret Sauer
said, “I think the ceremony was
very informative.

“It was interesting to learn the
history of Gesell. 1don’tthink a
lot of people know that it exists as
part of the education program,”
she said.

1997/1998 school year. (

Student technician, Jason Mechelke, finds himself busy at
work in the station. SVO is still accepting applications for the
(Photo by Carrie Reuter)

UWSP caeomites
Mudtilpml week

The face of our world has
changed. This is not a political
statement, but a fact.

Demographers conclude that
more races, cultures, and
ethnicities are in the workforce
than ever before.

The populations in our col-
leges and universities in rural set-

tings have not caught up with

these changes. Our progress
rests upon learning from one an-
other about one another.

Several institutions, including
UW-Stevens Point, have recog-
nized this and are creating pro-
grams to meet this need.

April 21-24 is “UW-SP Cel-
ebrates Multicultural Week 1997.
All the following events listed will
be held in the University Center.

. There are a variety of events for

this year’s celebration.
Monday, April 21, there will
be an Ethnic Movies/Food Sale.
The movies that will be shown
are: Heaven on Earth, Killing
Field and Last of the Dogman.
The movies will be shown free
of charge in the Anderson Room
fmm9am to830pm.

 The food sale by the Hmong/
Club

Southeast Asian

(HASSEEAC) will be from 9 a.m.
to 4 p.m., at booth #2.

On Tuesday, April 22, there
will be a panel discussion/display.

The HASSEEAC club will
have a panel discussion on cam-
pus life from 2 p.m. to4 p.m. in the
Nicolette-Marquette Room.

There will also be a bi-racial
panel discussion on ethnic iden-

tity in the Nicolette-Marquette

Room.

~ The HASSEEAC club will also
have a display at booth #2 in the
University Center.

On Wednesday, April 23,
there will be speakers and a fash-
ion show. The Native American
Club (AIRO) will present Walt
Bressette from 2 p.m. to 3 p.m. in
the Nicolette-Marquete Room.

Frank Montano will also be
speaking from 3 p.m.to4 p.m. in
the Nicolette-Marquette Room.

The day will close with the
fashion show given by the
HASSEEAC clubat 7 p.m. inroom
125-125A.

The week will close out with a
repeat showing of the movies on

 Thursday in the Anderson Roam
;frana.m to8p.m.




Features

: Word Of Mouth

a  The Susan Murphy Pitrowski Ceramic Awards Exhibition will
mbe shown in the Edna Carlsten Art Gallery at UW-Stevens Point. =
: The exhibition began March 31 and will run through Friday,:

® April 25.
"

]

||

L 3 1)
*TAKE BACK THE NIGHT .
]

= Domestic abuse, sexual assault and other forms of violence

:against women are most often hidden under veils of silence or face- g 2
- less statistics. Take Back the Night is an annual rally and march tog -
.protest violence against women and all people. .
: The event includes informative speakers, an open speak-out,®
wartistic expression, a march and finally a celebratory concert. The g
:rally will begin at 6 p.m. on Wednesday, April 23, in the unversity u

= Sundial.
| ]
| |

* COMEDY

= Comedian Carl Banks will be performing this Thursday, April 17 2
mat 8 p.m. in the Encore.

®  Banks has landed gigs on “In Living Color” and “Talk Soup.” g
mHe has also performed on “An Evening at the Improv” and “She-
2 TV,” toname a few.

m  Admission is $2 with UW-SP student ID and $3.50 without.

| ]

:PARTY

= Centertainment Productions’ Alternative Sounds Programming

:Area is having a birthday party to celebrate their 10 years on cam-:

mpus. The bash will take place on Saturday, April 19 at 8 p.m. in the®

:Encore Anyone is welcome to attend and admission is free. :

' Such bands as Bugattitype 35, a female trio from Madison, and l
Nude Eden, winner of UW-SP’s battle of the bands, will be perform-

:mg

|
s WINDY CITY TRIP

l Centertainment Productions is hosting a trip to Chicago Apnl:
.25 through 27. Transportation, two nights at the Essex Inn, and g
'tours all around the city will cost only $55. Be sure to sign up by
(] Aprll 22 at the Campus Activities Office. -
|
l | ]
a "
L] |
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Secret Rapture entices audiences

By Kerry Liethen

THEATRE CRITIC

UW-Stevens Point Theatre
and Dance Department presented
adark and tragic drama,
The Secret Rapture, this
past weekend at Jenkins
Theatre.

The play is setin En-
gland during the 1980’s
when Margaret Thatcher
became the ruler of the
country. England was
set on edge because of
the destruction of so-
cialism and the growth of capital-
ism in a new aggressive society.

The Secret Rapture likens the
tragedy of the Glass family to the
difficult times in England. The
production plays upon all aspects
of life from sex and booze to
money and power.

Rapture opens with the corpse
of Robert Glass (Scott Crane) ly-
ing in his bed, being held by his
daughter, Isobel Glass (Kelly
Hyde).

The story unfolds around
Isobel and her difficulties with her
sister, stepmother, and the con-
stant pain of her father’s death
lurking in the shadows.

In addition, Isobel’s lover,
Irwin Posner (Andy Peplinski) be-
comes just as controlling as her
family, especially when it comes
to business.

The cast for Rapture was
composed mostly of upperclass-
men and they delivered a clean
performance. However, there were
moments of overacting especially

Q& A With
Chancellor Tom

What is your favorite sport? Do you follow any UW-SP teams more than others?

In my early college years, I was on the wrestling and soccer teams. Later, | became a power lifter for
fun and tended to follow these three sports. Since coming to UW-SP, | have been introduced to so
many great teams across a wide variety of sports that [ enjoy watching them all. [ am also particularly
struck by the excellent facilities UW-SP students and our athletic teams enjoy.

How do you feel about the proposed smoking perimeters?

While indulging in an occasional cigar myself, I believe non-smokers are entitled to a simoke free
environment, and I understand that resolutions such as the one proposed by SGA are developed to
ensure the rights of non-smokers. This is an issue that [ am watching with interest, and [ have been told

that an answer to the question is expected by semester’s end.

when it came to emotional out-
bursts.

It seemed that whenever Sara
Oliver’s character, Marion French,
was upset she stomped across
the stage with arms flapping in the
air like propellers on a plane.

In addition, I have to say that
Costume Designer Heidi O’Hare
expressed her creative abilities in
Rapture more than she did in
Lady’s Not for Burning, which
was a sincere delight.

The makeup for Rapture was

BIRKENSTO(K.

The original comfort shoe.™

Happy Feet
SHOE SERVICE

54 Sunsct Blvd. - Stevens Point

Mon -Thurs. 8-5. Fn 8-7;

(715) 345-0184

Sat §-Noon

less than desirable because it was
very drab, as if the actors were
not wearing any at all. During the
80’s, makeup expressed woman-
hood; eyes were covered with
shadow and liner, while lips were
pursed in fiery reds and neons.
In addition, hair was sprayed
and curled until a mountain was
teased out of straight mops. Rap-
ture did not include any of these

The produc-
tion was supposed to
take place in the
1980’s, but a few of
 the costumes did not
_look like they were

from that decade.

In contrast, the
accessories were
very appropriate for

this production because the large
leather belts, huge earrings, and
short miniskirts defined that era.

-

SEE SECRET ON PAGE 18

=

After all this grad
has been through,

6 years at UWSP
3 majors
5 roommates
35 Belt's flurries
78 hangovers
200 pitchers of beer
248 packets of Ramen
noodles
149 boxes of mac & cheese
198 pizzas

Don't forget to congratulate
the grad on a job well done.
Get your grad cards & gifts
at the University Store!

NIVERSITY

e STORE
346 -3431

www.uwsp.edu \centers\bookstore
www.uwsp.edu \centers \textrental

<
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By Grundy and Wille : | HEARD You LAXATIVE FILLING INSTEAD

USED TO INITIAT OF CHOCOLATE. | 'D GIVE
ALL THE ROOKIES : THEM TO ROOKIES, AND THEN,
e JUST OBSERVE THE SCENE.
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| WAS COMING HOME ON [ [ HE WAS ENGAGED IN A
THE BUS LATE AT NIGHT, [ LOUD ARGUMENT WiTH
AND GEORGE BUSH WAS =) A LITTLE GIRL.
THE BUS DRIVER. —

“Hold on, guys. | think
| forgot something.”
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by Scott Bartell and Jesse Reklaw

trickle -down . Youre not even
economics is a Iist,ening to me!l
sham !/ we learned |l XX
that in the -

eightses!

Y we must
lower taxes

8 to stimulate
the economy!

nd Jesse Reklaw
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) WAS RELIEVED WHEN
WE REACHED MY 5TOP.

e e i L hitp:/lwwwnonDairy.com/slow/wave.cgi * submit your dreaml °* po box 200206 New MHaven, CT 06520-0206

“As you can see, the artist
painted this on site.”

BROWNING IT UP by Katherine Jordan James
/ \ P CROSSWORD AMERICA Edited by Fred Piscop }
ACROSS 3 Artistic category 31 Unique person
1 Droop 4 Lie adjacent to 32 "Bei Mer __ Du Sch™n”
4  Find the sum of | 5 End of existence 33 Villad'__
9 Assign a role to 6 Smack-__ (squarely) 34 Jeff Bridges film of '82
13 Mayberry boy 7  Half of deux 35 Shade of brown
14  Anti-gas product 8 Read carefully 37 Insane
15 Cracker brand 9 Shade of brown 40 Where to scratch
A -I -| 24, s = r r 16  Shade of brown 10 Verdi opera 42 Bahamas capital
18 Dirty-socks emanation 11 Hit the mall 45 Ernesto Guevara
19 Some retired 12 Pulled apart 48 On __ (upright)
- professors 13 Follow orders 50 . State confidently
20 Break out 17 Nose-blower's need 52 Hot winter drink
S l e 22 "Twenty questions” 21 "_ 'em!" (attack 54 More qualified
replies command) 55 Linda of "The Exorcist"
23 Rehearsal spot 24 Former heavyweight 56 Jockey's grip
26 Bock vessel 3 champ Witherspoon 57 Johnson of "Laugh-In"
28 Mild cigar 25 Single entity 58 Magazine launched in
32 The Beach Boys' “__ 27 Prefix for graph or 1937
to Your School® phone 59 Bullets
36 A thousand grand 29 World War Il foes 60 "The _ McCoys"
38 Nerve-cell part 30 Columnist Barrett 62 Slangy so-long
| Te X t Re n t a 39 Knesset member 65 Gl address
. : 41 "Last man” annuity 66 Larson's "The _ Side”
| scheme
‘ S u rl p u S 43 __ away (get a free
ride)
B O O k S 44 And so forth: Abbr. ' T CH COE o R R [ (£ [P
, 46 Kind of salad
47 _ Overstrung 12 e, 1>
‘ ° 49 Utter confusion ,, - -
| 51 What baseball's a
| game of 19 20 |2
53 Native-born 39-Across
58 South Texas city 2 n a1
: 61 Former quarterback S T = T T £
[ A gl T 14-20
p 63 "The _" (1976 32 [ [u s 38 3 38
‘ Gregory Peck film)
64 Shade of brown 29 40 41 42
67 Arabian Peninsula
sultanate & 4 o i
68~ lllusions in paint & m m 50
visit our web site! 69 h;_h';'einqk - W
achtmusik” 51 52
www. uwsp.edu\centers\textrental i s S o :
71 Main artery 58 |59 |60 61 |62
72 Santa Fe and others: = TR T ] '
Abbr.
67 58 69
DOWN
NIVERSITY s % B "
el el el o 3 2  Buenos
Sty ST i Enteractive, Inc. ©1996/Dist. By Creators Syndicate
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Kaquatosh

FIND OUT MORE ABOUT

LIKE SOME STALKER, T

FOLLOWED HER, NOT EVEN
SURE WHAT I'D SAY TD
HER. ONCE SHE'D NOTICE.

T SCARED HER BAD. SHE
GAVE ME THAT LOOK THAT
MEANT T HAD BEEN A JERK/

| HONEYCO)

My subconscious is
my telegraph machine
the psychic fax line

HEE

V/ THiS THERESA SNOW.. > |
1y \ . | HEY. . :
A 4 | — ’ 2 I'm contacting the
i / \ 1 hd ~
i ; L A\ N THegesH!
N Pt H{I\E | Ehe
1"’ .4 s 1 L !
:’ = \0 = \}\‘-.\\\\ L/ \‘/ ¥ I
1 7 : / & = \d VA=
" e o i Tl ( ! \
\ g — ) $
@ g e | = DN
. / ¥ - .. AND WHY SHE'S So . : 2 7
I\ ;/M )| Keewn ow MAKING MY \ 50 L JUST CALLED I FERK 0@ NOT, T TOOK ONE
3 \’4/ N DAVE 60 MERIBLE! | & / {I!_QW HE@ NAME . ) Look W KER Eves AnD—
‘ 70 MAKE up FoR '/ knaw LAY [l il HOPE You DON'T
B\ \ / SCARNG HER, T You THINK N %mjzér M SOME
el o, INVITED HER OVER-} | oF ME, BUT, (N KIND 0F PSYcHO
; TM NO FOOL, STEVE. * WENCH FRaM HELL. 25 7
DAVES FEELINGS FOR - A, THERESA =,
e el T soper.. 4
S0, WKy ARE Yo -
HERE .. - hah? 7 yie K\\
N = a 2 A
JPa27" .
=7 ) —
\' = 7= i
¢ 70 FINALLY PUT THE\S ( £
ANDSM‘/SAW' \ e \ A PAST BEHIND ME, \ T 1 TUST, .. : o v v
WHAT DAVE MUST | = cuess. AnD 10 ROTECTIVE 0F my skin hums A red chrome motor
) ONCE SAW IN HER. e LET DAVE KNOW DAVE. HE'S GaT | @ g
CUTE AP THAT T REALLY... A BlG YM-HUM. my eyes spark fueled by this
7 .5'/‘/5 WAS . \ i v LovED HIM. Saame/ g
AND WHAT AGour YOU? e = 2 : : endless activity--

7 ColNAT AGOKT FE %ﬁgﬁ” KNOW o %\g OH, SWEET GIDS. .. all these dreams flowing
v 7 M) a2 ) ( \ over over flowing me
/ \ n b/ fre — memories spinning

[~ 4... TH(S SHouLD 7/ ) e
} & uhp. . e\)w NOT - HAVE.. : , spinning me to where
HAPPENED, ~ —= I need
BN DAVE. WONT— /;/a need to go...
& DN = )
\ He oes'T 1 \\ / f and who I work to Bee.
uae o [y V.
Yok HEART Z > bVl 1 [T /
\\\\» T aem 7 \ 7/ By Valentina Kaquatosh
75 THROUGH YOUR SMNTT ‘N ArTs & REVIEW EDITOR
7% e Zve Auvays Been| WO, You DoN'T (T M NEVER 6‘7;2’5:/
) [ano ATS AL 1 au. | A LOVER o worten.| R UNDERSTAND,, D Mlinidic PoEEiE
; 27
Next Week: Sweet Dreams Screw Up Things

Sling Blade a cut above the rest Ultra returns to

By Mike Beacom

EpiTor-mN-CHIEF

Billy Bob Thornton caught
everyone’s attention when his
screenplay for the not-too-well
known “Sling Blade” took hon-
ors at last March’s Academy
Awards.

The Best Adapted Screenplay
winner definitely deserved the
attention and the award. Unfor-
tunately, just like the Academy
failed to nominate 1996’s Best
Original Screenplay winner,
“The Usual Suspects,” for the
best picture award, it failed to
nominate “Sling Blade.” It is one
of the better pictures I have seen
in quite some time and more-de-
serving of a nominee than “Jerry
Maguire.”

The story takes place in a
small Arkansas town where a
partially retarded man named

Karl (Thornton) is released from
a mental hospital where he had
been placed twenty-some years
earlier for murdering his mother
and her lover.

Karl returns to his hometown
where he receives a mixed re-
sponse from the townspeople. He
befriends a boy who convinces
his mother to let Karl stay in their
garage. Although the two em-
brace Karl, the mother’s boy-
friend, played very well by
Dwight Yoakam, has little toler-
ance for him.

Karl sees the resemblance be-
tween the boy’s childhood and his
own. That is how the two relate
and the similarities Karl sees are
responsible for his actions
throughout the movie.

“Sling Blade” is very well
acted and its plot continually
grows throughout the movie. I
highly reccomend it.

Supporting Cast: Robert
DuVall, John Ritter, Lucas Black.

Rating (four possible):

L ddd

Rentals

The Basketball Diaries
(1995; 102 min.)

This is the disheartening tale
of Jim Carroll, noted poet, musi-
cian and ball player.

Leonardo D’Caprio plays the
somewhat disturbed Carroll with
the passion that we have come to
expect from an actor that repre-
sents the future of Hollywood.

The film is a emotional ride
through the depths of depression
and depravity. It is about the de-
struction of youthful innocence
and the jarring trip into manhood
on the streets of New York.

If you want to be depressed,
see this movie. If you want to
see the evils of drug addiction at
a young age, indeed any age, see
this movie. If you are looking for
a good time, rent something else.

Supporting Cast: Mark
Wahlberg, Lorraine Bracco,
Bruno Kirby, Juliette Lewis.

-Nick Katzmarek

familiar Mode

90 FM’s Pick of
the Week

By Patrick McGrane

Music Critic

Ever since they broke onto the
scene in 1981, Depeche Mode
has been providing music fans
with some of the best in modern
infectious grooves.

Their sound was a major part
of the 80’s “gothic sound” move-

and propelled by other favorites
such as Joy Division and The
Cure. Their discography in-
cludes 9 fulllength albums, four
compilations, and three live al-
bums.

Their last full-length, 1993’s
“Songs of Faith and Devotion”,
deviated from their former styles
and progressive sounds, leaning

ment, huge in the UK club scene,

towards a more rock-oriented
sound.

Their latest offering, “Ultra”,
is a continuation of older themes
and styles.

The rock-edge heard on
“Songs of Faith and Devotion”
has, for the most part, been aban-
doned. There is once again that
moody and darkened approach to
their song-writing, resulting in
songs that are passionate and
powerful-the very essence of what
brought them their original popu-
larity. "

This isn’t a return to a retro-
80’s sound, it is more of a con-
tinuation of their original gothic
sound, incorporating it into a pro-
gressive 90’s style that is both
appealing and inviting.
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 Give yourself a little credit this summer!
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UWM SUMMER SESSIONS OFFERS

SUMMER SESSIONS

EEEEENEEEEEEEEEEER
UNIVERSITYor WISCONSIN MIDWAUKEE

NEARLY 3,000 CLASSES THIS SUMMER.

FREE SCHEDULES AVAILABLE BY CALLING
414-229-6732

OR
Visit the UWM web-page at:
http://www.uwm.edu

UWM

y .®

UNIVERSITYor WISCONSIN MIIWAUKEE
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elements that were so important
to that time.

I suggest that the makeup de-
signer should go back and look at
an 80’s yearbook to remember
what people looked like in that
time.

Overall I did enjoy the produc-
tion and I believe this is due to
the direction of the play.

The blocking did not appear
to be mechanical or foreign to the
characters, but natural and au-
thentic. Adrianne Krstansky, the
Director of Rapture, obviously
had a strong rapport with her cast,
because the production appeared
to run quite smoothly.

I give the cast and crew of The
Secret Rapture a B. The story was
dark and brooding, which had a
mystical effect on me. Maybe this
was due to the background mu-

' sic, but that is unlikely.

The Secret Rapture will also
run April 17, 18, and 19 at UW-
SP’s Jenkins Theatre. For ticket
information call the Arts and Ath-
letic Office located in the Quandt
Fieldhouse.

See news
happening?
Call
The Pointer
at 346-2249.

MATC's flexible summer dlass schedule
enables you to earn liberal arts credits
without cramping your work or social schedule.

CREDITS THAT TRANSFER TO UW-SYSTEM SCHOOLS.

So while you're home this summer,
engage in some liberal thinking.

(414) 297-MATC

to enroll or request a
summer school schedule™

Milwaukee Area Technical College
Mequon e Milwaukee ® Oak Creek ® West Allis

MATC is an Atfirmative Action/Equal Opportunity Institution and
complies with all requirements of the Americans With Disabilities Act.

Read
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nomenal,” Randlett said.

All students who are enrolled
in a course which has a collabora-
tive reading-adjunct program may
sign up. Although the majority of
the enrollees are either freshman
or sophomores; upper level
classmen also join the program.

Reading Adjunct Program
Assistant Laurie Meyers said the -
program, allows students to com-
prehend difficult readings and the
friendly atmosphere created
within the classes allows students
to ask questions they wouldn’t
normally ask in the classroom.
Before working for the university
Meyers taught as a tutor at UW-
SP for three years.

“It’s interesting running a read-
ing-adjunct program,” Meyers
said.

Adjunct classes are taught by
students who have been recom-
mended by professors. The stu-
dents are required to take a spe-
cial semester long course de-
signed on how to tutor.

“It’s an incredible leadership
opportunity to work with groups
and professors,” said Tara
Hofkens, a tutor in three disci-
plines. :

Students currently enrolled in
the program feel their experiences
in reading-adjunct have helped
them in their studies. “(The Read-
ing-Adjunct program) is a fun
way to take a different approach,”
said UW-SP freshman Justin
Breyhan.

“I think it helps with practical
education we learned in class,”
Freshman Tracy Righi added.

The adjunct class requires stu-
dents to write a one page paper
per week on their studies. The one
credit program also requires stu-
dents to write final paper on how
the reading adjunct program has
help them.

Professors who work closely

i with the student tutors believe the
. program benefits students. “I

think its a wonderful program for
students,” said Philosophy Pro-
fessor Tom Overholt. Overholt
added that he has at least one of
his classes in the last four years.
History Professor Eric Yonke
said the program lets students un-
derstand the class materials.
Although the program has
achieved great success in little
over a decade the recent tighten-

- ing of the budget belt has forced

the program to keep its numbers

. down.

“We would like to see it con-

~ tinue to flow,” said Randlett.

By combining information
given in lectures by professors
and the different tactics of the
reading adjunct program, students
can puzzle together a picture of a
quality education.
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EMPLOYMENT

O U .S . I.N G

HOUSINGEH OUSIN GEH

EMPLOYMENT

SuMMER RENTALS
Close to campus. Clean.

Reasonable rent.
Call; 344-7487
or e-mail:
msandstr@coredcs.com

SummER HousING

Large single rooms, across street
from campus. Reasonable rate is
for full summer and includes
utilities. Cable and phone jacks
in all bedrooms. All houses are
nicely decorated; bedrooms and
kitchens are furnished. Parking
and laundry facilities. Betty or
Daryl Kurtenbach.

Call: 341-2865
APARTMENTS FOR RENT

97-98 school year. Also summer
rental from 1 to 4 bedroom
apts. Shaurette St.

Call: 715-677-3465

Vacancy For Two

For fall ‘97. Summer open-
ings for 2 or.3. Single rooms,
nicely furnished. Beverly
Apartments.

Call: 344-2278

SumMER HousING
3 bedroom apartments. Uni-
versity Lake. $450/month.

Call: 345-2396

UNIVERSITY LAKE APARTMENTS
3 bedroom apartments, school
year leases. Ask about unique
payment plan.

Call: 345-2396

ANCHOR
APARTMENTS

Housing, Duplexes, Apart-
ments. Very close to campus,
1,2,3,4,0r 5 bedrooms, profes-
sionally managed, partially fur-
nished, parking & laundry fa-
cilities. Call now for 1997-98
school year. 1 block from cam-
pus. Please leave message. Im-
mediate openings.

Call: 341-4455 or
344-6424

97-98
HousING

Various Sizes
And Locations

Call:

F&F

Properties

Call: 344-5779

OFr Camprus HoOusING
97-98 school year. Groups 4-
6. Call Peter.

Call: 341-0312 or
344-1151

PERSON(S) NEEDED

To occupy own room in newer
3br apartment. Close to cam-
pus. Reasonable rent. Avail-
able now! Includes: carpet,
drapes, stove, fridge, micro, d/
w, private laundry and off
street parking. Parker Broth-
ers Realty.

Call: 341-0312

SUMMER RENTALS

Quality furniture & appli-
ances. Privacy Locks, Cable,
phone jacks in all bedrooms,
ceiling fans, blinds, laundry
mat, parking, heat, electric,
water included in rent. Ac-
commodating 1-5. A nice
place to live.

Call Betty or Henry: 344-2899

SpLiT HOUSE FOR 97-98

5 rooms each side. Private
room $725/semester. Single
tenants or groups welcome.

Call Christy at: 346-5919

AVAILABLE JUNE 1

6 bedroom house, 4 blocks
from university. Summer and
fall rental.

Call after 5:00: 341-1912

ONE FEMALE

Next year share a nice house
with nice woman. Your own
bedroom.

Call: 341-3158

97-98 ScHooL YEAR

5 bedroom 2 bath nicely deco-
rated home for 5. Furnished
including washer and dryer,
plenty of free parking, nice
location. Individual leases for
9 or 12 months.

Call: 341-2248 or 345-0153

EASTPOINT
APARTMENTS

341-6868

--Large One Bedroom

--3 Blocks from Campus
--Laundry, Air, New Flooring
--Many New Improvements

--Garages Available

Rates:
$365.00 - 9 month
$325.00 - 12 month
$315.00 - 15 month

$235.00 - Summer
$35.00 - Garage

FaLL HousInG

Vacancy for 1 female to share
a modern 5 bedroom home,
1/2 block from campus with
4 other nice college girls. Pri-
vacy locks, cable, phone jacks
in all bedrooms.

Call Henry or Betty: 344-2899

Stubent HousinG 1997-1998

2232 Main Street (Next to

Nelson Hall). Licensed for 5,

separate bedrooms, 2 bath,
rec room, large living room.

Call: 341-1471

BEAUTIFUL APARTMENT
Up to 5 people, 1/2 block
from campus, offers single
rooms. Washer and dryer,
parking available.

Call Henry ASAP: 344-2899 or

342-9297

MALE SUBLEASER NEEDED

For 1997-1998 school year.s
2 1/2 blocks from campus.
Cable & TV jack in bed-
rooms. Laundry & parking
facilities. Recently remodeled
in and out. Deadbolt locks on
all doors. Furnished, energy
efficient, and very clean.
Bonus: Security deposit
already paid!

Call Dan at: 345-6372
or Daryl at: 341-2865

* $200-$500 WEEKLY *

Mailing phone cards. No
experience necessary. For
more information send a
self-addressed stamped en-
velope to: Global Commu-
nication, P.O. Box 5679,
Hollywood, FL 33083

GIRrRL Scoutr Camp

Hiring counselors, unit
leaders, waterfront director &
cooks for June 12 through
August 12. 45 min. N of Eau
Claire. Call “Chance,”
director for an application
packet and on-campus
interview. Cool summer fun!

Call: (847) 741-5521

$1000’s PossIBLE

Reading books. Part time. At
home.

Call: 1-800-218-9000
ext. R-9457

HEeLP WANTED

Summer in Chicago. Child
care and light house keeping
for suburban Chicago fami-
lies; responsible, loving non-
smoker. Call Northfield Nan-
nies.

Call: (847) 501-5354

ScHooL OF EpucATioN
Is recruiting for Graduate
Assistants for the 1997-1998
academic year. Deadline for
application is April 25.
Forms are available in room
470-A, CPS.

HELP WANTED

Men / Women earn $480
weekly assembling circuit
boards/electronic components
at home. Experience unnec-
essary, will train. Immediate
openings your local area.

Call: 1-520-680-7891
ext. c200

CAMmP STAFF POSITIONS

Easter Seals Camp Wawbeek/
Respite & Recreation Center
have summer positions
available. Great experience
working with a variety of
people with disabilities.
Contact Derrick or Chris.

Call: (608) 277-8288

$1000’s PossiBLE TYPING
Part time. At home. Toll Free.

Call: 1-800-218-9000
ext. T-9457

FOR SALE

WaAIT TRAINING FITNESS LETTER

For intermediate and above
level athletes. Confprehensive

and time-efficient. Send $17.50

to: Weight Training Fitness
Systems, PO Box 33646, La
Crosse, WI 54602-3646

Gov’t ForecLosEpD HOMES

From pennies on $1. Delin-
quent tax, repo’s, REO’s.
Your area. Toll Free.
Call: 1-800-218-9000
ext. H-0457

SEIZED CARS
From $175. Porsches,
Cadillacs, Chevys, BMW’s,
Corvettes. Also Jeeps,
4WD’s. Your area. Toll Free.
Call: 1-800-218-9000
ext. A-9457

SERVICES

EMPLOYMENT

m FREE FiLm FESTIVAL
Friday, April 18. 5 PM-Laura
EMPLOYMENT | 5500 Hearo o Picho
Room 333 Communication
At The Summertime Building.
Restaurant in beautiful Y orr & Poies
Door County, WI. All
it lable. T The Psychology Dept. has many
sl a. S sp items that were lost in class-.
wages paid. rooms. Please come to D240-Sci-
ence to identify and claim
To apply, please call
Terry Bolland at (414) T CICICIE
868-3738; PNENE BEONE CNDE
BIU|RIN|T|UIM|B|E|RJIO|D|OIR
fax (414) 868-2683; EM[E[R[1[T] | MM E|S|C[A[P[E
. Y|(E|S|E|SEMS|T[UID|I]|O
e-mail: tholland @ s{T[e[ [NJC|LIAIR[O
s AEERANE NN DBRED
mail.wiscnet.net; ([s[RIA[E[L] | MRTIOIN[T[1|N]E
or write PO Box 400 T E s e Cl A o] N
Fish Creek, WI 54212 CTATRIE (DI I TIAB L €]~
_Q__li_E_N C|AIFIEJAJU[LIA[IIT
OM/AINEEO|PIAIR|T E|IIN|E
KIO|LIABBAIOIR|TIABMRIR|S
Answer to previous puzzle

Student Look To Career Look

Clear, healthy skin & a polished image. . .
essential for anyone in the 90’s
competitive job market.

FREE FREE FREE:

-Color Analysis-Skincare Clinic-Cosmetic Tips
Interview/Career Image Consulting
PLUS: Get 3 Frineds Together and Receive

. $100 worth of products for $35!

Call Chris Charewicz, Certified Consultant
341-7227 or 341-6074

BeauhControl.Cosmetics

THE WORLD S PREMIER

e
INAGE COMPANY.

IRTHR]GHT And Need Help?

Free and Confldentlal.

PREGNANT?

Call 341-HELP




b

PAGE 20 APRIL 17,1997

ts [rivia Madness!

11 Days Only — April 10th to April 20th

ANY PIZZA
ANY SIZE
ANY TOPPINGS

$

~ 799
O :

/ :
: * $1.00 Extra for Deep Dish and
i £ Flavored Crust

e Excludes Dominator
¢ No Double Toppings Please
e Expires 4/20/97




